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Executive summary 
Lifecycle Controller provides an infrastructure for installing operating systems on PowerEdge servers 

using Dell-supported driver packs.  You can install operating systems  in an unattended mode for both 

legacy BIOS and UEFI boot modes.   

 

This white paper provides detailed information on installing the Red Hat Enterprise Linux 7 operating 

system in an unattended mode using Lifecycle Controller. 
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Introduction 
The OS Deployment feature available in Lifecycle Controller enables you to deploy standard and custom 
operating systems on the managed system. You can also configure RAID before installing the operating 
system if it is not already configured. 

You can deploy the operating system using any of the following methods: 

 Manual installation 

 Unattended installation 

The unattended installation feature requires an OS configuration or answer file. During unattended 
installation, the answer file is provided to the OS loader. This activity requires minimal or no user 
intervention. Currently, the unattended installation feature is supported only for Microsoft Windows and 
Red Hat Enterprise Linux 7 operating systems from Lifecycle Controller. 

Note: This paper only covers unattended installation of Red Hat Enterprise Linux 7 operating system from 

Lifecycle Controller. For more information about unattended installation of Microsoft Windows operating 

systems, see the “Unattended Installation of Windows Operating Systems on Dell PowerEdge Servers by 

Using Lifecycle Controller” white paper available at the Dell TechCenter. 
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1 Unattended OS installation using Lifecycle Controller—

process flow chart   
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2 Unattended installation of an operating system  
Before performing unattended OS installation, make sure that the following prerequisites are met: 

 OS configurations file (ks.cfg for Red Hat Enterprise Linux 7) is created. To create the operating 
system configurations file, see the Annexure section.  

 OS configurations file is copied to a USB drive or network share (CIFS/ NFS) for Lifecycle 
Controller to import. 

 Optical DVD drive with OS media is connected to the server, or a virtual disk (.ISO image) is 
attached to the server. For more information, see the Attaching Virtual Media section. 

 Software RAID controller is enabled or PERC controller is installed, and a minimum number of 
hard-disk drives (HDDs) are available for creating a virtual disk. If the RAID is not already 
configured, then, the OS Deployment wizard in Lifecycle controller enables you to configure RAID 
before installing an OS. 

To install an OS using the Unattended Install mode: 

1. Press F10 during POST to launch Lifecycle Controller. 
2. In the left pane, click OS Deployment. 
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3. In the right pane, click Deploy OS. 
OS deployment logic verifies whether an optical DVD drive is connected to the server or a virtual DVD 

drive is attached to the server. It also checks the presence of a virtual disk. It is recommended to have the 

necessary hard-disk drives in the system.  
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4.  After clicking Deploy OS, if an optical DVD drive is connected or a virtual DVD is attached and 
virtual disk is already present, then the Select Deployment path page is displayed. If a virtual disk is 
already configured, select Go Directly to OS Deployment, and then click Next. Else, select 
Configure RAID First, and click Next to configure RAID or edit an existing virtual disk. For more 
information, see the Configuring RAID section in the white paper. 
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5.  On the Select an Operating System page, select the following options. 

 Boot Mode — Allows you to select the boot mode — BIOS or UEFI. The operating systems in 
the Available Operating System drop-down list box is populated based on the boot mode 
selected. 

 

 Secure Boot — Allows you to enable or disable the Secure Boot option. Click Enabled to 
secure the boot process if the drivers are signed with an authorized digital signature. This 
option is available only for the UEFI boot mode. For more information on Secure Boot, see 
“Enabling Secure Boot on Dell PowerEdge Servers” white paper. 

 Secure Boot Policy — Displays the current setting of the policy in the BIOS. 

o You can change the Secure Boot Policy setting only in BIOS. To enter BIOS in the 
system setup, press <F2> during POST. 

o The Secure Boot and Secure Boot Policy options are available only on the Dell 13th 
generation PowerEdge servers and later. 
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 Available Operating Systems — Displays the list of operating systems depending on the boot 
mode selected. Select the operating system to install on the server. 

Note:  

 If you select Any Other Operating System, make sure that you prepare the drivers required for 

installing the operating system as no drivers are extracted from the internal memory. 

 The list of Dell-supported OS changes based on the driver packs updated on the system. To 

update to a latest driver pack, see the Updating Driver Pack section. 

 For Citrix and ESXi operating systems, it is recommended to use Dell-customized OS images. 

 The software RAID controller supports installation of Windows operating system only. 
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6.  Click Next. After clicking Next, the OS drivers for the selected OS are copied to a temporary drive 

(from which the OS installer picks up the drivers for auto installation). This process takes a few 

minutes to complete based on the drivers and their size. 

 

 

7. On the Select Installation Mode page, select one of the supported installation modes for the 
selected OS Installation.  

Note:  

The Unattended Install option is enabled only if the operating system is compatible for an unattended 

installation. If the operating system is not compatible, the option is grayed out. Currently, Lifecycle 

Controller is limited to supporting unattended OS installation only for theWindows  and Red Hat 

Enterprise Linux 7 operating system.  
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8. On the Select Installation Mode page, select either USB drive or Network Share to import the OS 
configuration file, and then click Next.  
Prerequisite: 

a) OS configurations file (ks.cfg for RedHat 7) is created. To create Operating system 
configurations file, refer to the Annexure section.  

b) OS configurations file is copied to a USB drive or a Network share (CIFS/ NFS) for Lifecycle 
Controller to import. 
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After you click Next, a message is displayed as shown in the screen shot below. The OS configuration 
file is verified and copied to a temporary drive. The OS loader picks up the OS configuration file for an 
unattended OS installation from the temporary partition. If different versions of OS configuration files 
are stored in any of the attached USBs, the system may pick an incorrect file. To avoid incorrect 
selection of OS configuration file, ensure that you remove the incorrect configuration files or all the USB 
drives that are connected to the system.  
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If an incorrect file path is entered, or if the file does not exist at the specified location, an 
error message is  displayed.  

 

 

If an invalid OS configuration file is detected, a warning message is displayed. Make sure 
that the OS configuration file is valid and named as “ks.cfg”.  

 

 

 

9. On the Insert OS Media page, insert the operating system media, and then click Next. 
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If the inserted media is not compatible with the selected OS, the following warning message appears:  

 

 

 

 

 

If the media is not present, the following warning message appears 
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10. On the Reboot the System page, click Finish to begin the unattended OS installation process. You 
must reboot the server for this process to begin. 
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3 Provide OS configuration file path by editing the 

configuration option 
Red Hat Enterprise Linux 7 does not support an auto pickup of the OS configuration file from OEMDRV. 

Hence, you must modify the command line configuration options to provide the OS configuration file 

path. The following sub sections provide details of the command line options which you must edit to 

install the Red Hat Enterprise Linux 7 operating system in UEFI or BIOS mode using the unattended install 

method.   

3.1 BIOS mode unattended OS installation 
1. After clicking Finish on the Reboot the System page, the system reboots and directs you to the 

following screen. Press “Tab” to view the full configuration options. 

 

2. In the screen that appears, delete quiet. 
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3. Add usbcore.autosuspend=-1 to the command. 

Note: You must add this command only if you are using the iDRAC virtual console.  
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4. Add ks=hd:LABEL=OEMDRV to the command. 



 

 

22 Unattended Installation of Red Hat Enterprise Linux 7 Operating System on Dell PowerEdge Servers Using iDRAC With 

Lifecycle Controller  

 

5. Press Enter to start the unattended OS installation process.  
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3.2 UEFI mode unattended OS installation 
1. After clicking Finish on the Reboot the System page of LC-UI, the system reboots and directs you 

to the following screen. Press e to view the full configuration options. 

 

2. In the screen that appears, delete quiet and rhgb (if available). 
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3. “usbcore.autosuspend=-1” (Required only if you are doing this over iDRAC virtual console). Append 

“ks=hd:LABEL=OEMDRV” (Always required). 

 

4. Press F10 or Ctrl X to start the unattended OS installation.color of the text is blue. 
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4 Supported operating systems 
Lifecycle Controller supports all the popular operating systems in the industry.  The list of the 
supported operating systems depend on the driver pack installed on the server. To get the latest 
supported OS list, update the latest Lifecycle Controller OS driver packs using the Firmware Update 
feature of Lifecycle Controller. 

When installing an OS using Lifecycle Controller, OS Deployment extracts the OS drivers of the 
selected OS from the driver pack and copies them to a temporary folder location on the server. OS 
loader gets the drivers from this temporary location while installing the OS. This temporary location is 
deleted: 

 After an 18-hour period 

 When Lifecycle Controller is started 

 When an AC power cycle is performed 

Note: Lifecycle Controller has embedded drivers that are factory-installed.  To get the latest supported 

OS list or latest Lifecycle Controller OS driver packs, update the latest Lifecycle Controller OS driver 

packs using the Firmware Update feature of Lifecycle Controller. The latest Lifecycle Controller driver 

packs are available ondell.com/support.  

4.1 Configuring RAID  
To configure a RAID:  

1. In the left pane of Lifecycle Controller, click OS Deployment. 

2. Click Deploy OS in the right pane. 

3. Select the Configure RAID First option and click Next. The RAID Configuration page is launched 
and displays the available storage controllers for configuration. 

4. Select a storage controller and click Next. The supported RAID levels are displayed on the basis of 
hard drives available and the capability of the selected RAID controller.   

5. Select the appropriate RAID level, click Next to complete RAID configuration wizard. After the 
RAID configuration is applied to the hard disk drives, the OS list page (Step 2 of 6: Select an 
Operating System) is displayed after the RAID is created. For more information about RAID 
configuration, refer white paper “Creating RAID Using Lifecycle Controller”. 

4.2 Updating Driver Pack 
To update the driver pack: 

1. On the Lifecycle Controller home page, click Settings-> Network Settings. 

2. Set the appropriate network properties, and then click Finish.   

To get the latest driver packs, update the Lifecycle Controller OS driver packs using the Firmware 
Update feature of Lifecycle Controller. The latest driver packs are available on ftp.dell.com or 
dell.com/support. 
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For more information about updating a driver pack, see Lifecycle Controller User’s Guide available at 
dell.com/support/home, or the Lifecycle Controller Platform Update in Dell PowerEdge 12th 
Generation Servers  white paper at the Dell TechCenter.  

4.3 Selecting an operating system not available in the List 
To install an operating system that is not available in the list: 

1. Start Lifecycle Controller. on the Step 2 of 5: Select an Operating System page, select the option 
Any Other Operating System and click Next. 

2. Provide the required drivers for installing an OS, because the drivers are not extracted from the 
embedded driver pack. 

3. Insert the OS installation media, and then click Next. 

NOTE: Lifecycle Controller does not validate the media if Any Other Operating System option is 

selected. 

4. Click Finish to reboot the system.  

4.4 Attaching virtual media 
To attach a virtual media: 

1. Start virtual console from the iDRAC GUI and attach the virtual media. 

2. To add an ISO image, click Add Image, and then select the image file from the management 
station. The ISO image is displayed as an available device.  

3. To add a folder that has the ISO image, click Add Folder as Image. 

Note: For more information about attaching a virtual media, see the iDRAC User’s Guide  available at 

dell.com/support/home. 

Conclusion 
Using the unattended OS deployment feature in Lifecycle Controller you can install an OS with 

minimal manual intervention which results in reducing the number of errors that may occurr during an 

OS installation process.    
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Annexure    
The Red Hat Kickstart installation method is used primarily (but not exclusively) by the Red Hat 
Enterprise Linux operating system to automatically perform unattended operating system installation 
and configuration. Kickstart is normally used to allow easy installation and consistent configuration of 
new computer systems. 

Kickstart configuration files can be built-in three ways: 

. Manual creation of ks.cfg file. 

. By using the GUI system-config-kickstart tool. 

. By using the standard Red Hat installation program Anaconda.  

Note: The following description of creating an OS configurations files (ks.cfg) is derived from the 

information available on the Internet. The details provided below covers only one of the use-cases to 

create an OS configurations files and does not cover all the configuration parameters. 
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5 Creating an OS configuration file  
Kickstart configuration files can be built in three ways. 

5.1 Manual creation of OS configuration file 
The following is an example of the kickstart option. You can get more detailed information on 

available options from Reference 2 & Reference 3. 

a. Installation Option Section: 

The first part of a Kickstart file defines the installation options and their associated values, and it defines 

how to configure the system storage, for example: 

#platform=x86, AMD64, or Intel EM64T 
#version=DEVEL 
# Firewall configuration 
firewall --enabled --service=ssh 
# Install OS instead of upgrade 
install 
# Use CDROM installation media 
cdrom 
repo --name="Oracle Linux Server" --baseurl=cdrom:sr0 --cost=100 
# System authorization information 
auth  --useshadow  --passalgo=sha512 
# Root password 
rootpw --iscrypted SHA512_password_hash 
# Use graphical install 
graphical 
firstboot --disable 
# System keyboard 
keyboard us 
# System language 
lang en_US 
# SELinux configuration 
selinux --enforcing 
# Installation logging level 
logging --level=info 
# System timezone 
timezone  America/Los_Angeles 
# Network information 
network  --bootproto=dhcp --device=eth0 --onboot=on 
# System bootloader configuration 
bootloader --append="rhgb crashkernel=auto quiet" --location=mbr --driveorder="sda" 
# Non-administrative user 
user --name=user --homedir=/home/user --password=SHA512_password_hash --iscrypted 
# Partition information 
clearpart --all --drives=sda 
part /boot --fstype=ext4 --size=500 
part pv.008002 --grow --size=1 
volgroup vg_hostname --pesize=4096 pv.008002 
logvol / --fstype=ext4 --name=lv_root --vgname=vg_hostname --grow --size=1024 --maxsize=51200 
logvol swap --name=lv_swap --vgname=vg_hostname --grow --size=2016 --maxsize=4032 
 
 
 
 

b. Package Section: 
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The %packages section defines the packages to be installed on the system, for example: 

%packages 
@base 
@client-mgmt-tools 
@core 
@debugging 
@basic-desktop 
@desktop-debugging 
@desktop-platform 
@directory-client 
@general-desktop 
@graphical-admin-tools 
@identity-management-server 
@input-methods 
@internet-browser 
@java-platform 
@legacy-x 
@network-file-system-client 
@network-tools 
@perl-runtime 
@print-client 
@remote-desktop-clients 
@security-tools 
@server-platform 
@server-policy 
@system-admin-tools 
@x11 
mtools 
pax 
python-dmidecode 
oddjob 
wodim 
sgpio 
genisoimage 
device-mapper-persistent-data 
abrt-gui 
samba-winbind 
certmonger 
openldap-clients 
pam_krb5 
krb5-workstation 
ldapjdk 
slapi-nis 
libXmu 
perl-DBD-SQLite 
perl-Mozilla-LDAP 
%end 

5.2 Using the GUI system-config-kickstart tool 

Kickstart Configurator allows you to create or modify a kickstart file using a graphical user interface, so 
that you do not have to remember the correct syntax of the file. To install Kickstart Configurator run su - 
yum install system-config-kickstart or use your graphical package manager to install the 
software. 

To launch Kickstart Configurator, boot your system into a graphical environment, then run system-config-
kickstart, or click Applications → System Tools → Kickstart on the GNOME desktop or Kickoff Application 
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Launcher+Applications → System → Kickstart on the KDE desktop. As you are creating a kickstart file, 

you can click File → Preview at any time to review your current selections. To start with an existing 

kickstart file, select File → Open and select the existing file. 

To get the detailed information on how to use Kickstart Configurator,  see Reference 5 to Reference 16. 

5.3 By using the standard Red Hat installation program Anaconda 

Anaconda will produce an anaconda-ks.cfg configuration file at the end of any manual installation. This 
file can be used to automatically reproduce the same installation or edited (manually or with system-
config-kickstart). File can be found in /root directory or /root/Anaconda directory. 
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Further references 

1. Unattended Kickstart (Linux):  http://en.wikipedia.org/wiki/Kickstart_(Linux) 
2. Creating a Kickstart File: http://docs.oracle.com/cd/E37670_01/E41137/html/ch03s01.html 
3. Kickstart Options: https://access.redhat.com/site/documentation/en-

US/Red_Hat_Enterprise_Linux/6/html/Installation_Guide/s1-kickstart2-options.html 
4. Starting a Kickstart Installation: https://access.redhat.com/site/documentation/en-

US/Red_Hat_Enterprise_Linux/6/html/Installation_Guide/s1-kickstart2-startinginstall.html 
5. Kickstart Configurator (Basic Configuration): https://access.redhat.com/site/documentation/en-

US/Red_Hat_Enterprise_Linux/6/html/Installation_Guide/ch-redhat-config-kickstart.html 
6. Kickstart Configurator (Installation Method):  

https://access.redhat.com/site/documentation/en-US/Red_Hat_Enterprise_Linux/6/html/Installation_Guide/s1-
redhat-config-kickstart-install.html 

7. Kickstart Configurator (Boot Loader Options):  https://access.redhat.com/site/documentation/en-
US/Red_Hat_Enterprise_Linux/6/html/Installation_Guide/s1-redhat-config-kickstart-bootloader.html 

8. Kickstart Configurator (Partition Information):   
https://access.redhat.com/site/documentation/en-US/Red_Hat_Enterprise_Linux/6/html/Installation_Guide/s1-
redhat-config-kickstart-partitions.html 

9. Kickstart Configurator (Network Configuration):   
https://access.redhat.com/site/documentation/en-US/Red_Hat_Enterprise_Linux/6/html/Installation_Guide/s1-
redhat-config-kickstart-network.html 

10. Kickstart Configurator (Authentication):   
https://access.redhat.com/site/documentation/en-US/Red_Hat_Enterprise_Linux/6/html/Installation_Guide/s1-
redhat-config-kickstart-auth.html 

11. Kickstart Configurator (Firewall Configuration):   
https://access.redhat.com/site/documentation/en-US/Red_Hat_Enterprise_Linux/6/html/Installation_Guide/s1-
redhat-config-kickstart-firewall.html 

12. Kickstart Configurator (Display Configuration):   
https://access.redhat.com/site/documentation/en-US/Red_Hat_Enterprise_Linux/6/html/Installation_Guide/s1-
redhat-config-kickstart-xconfig.html 

13. Kickstart Configurator (Package Selection):   
https://access.redhat.com/site/documentation/en-US/Red_Hat_Enterprise_Linux/6/html/Installation_Guide/s1-
redhat-config-kickstart-pkgs.html 

14. Kickstart Configurator (Pre-Installation Script):   
https://access.redhat.com/site/documentation/en-US/Red_Hat_Enterprise_Linux/6/html/Installation_Guide/s1-
redhat-config-kickstart-prescript.html 

15. Kickstart Configurator (Post-Installation Script):  
https://access.redhat.com/site/documentation/en-US/Red_Hat_Enterprise_Linux/6/html/Installation_Guide/s1-
redhat-config-kickstart-postinstall.html 

16. Kickstart Configurator (Saving the File): 
https://access.redhat.com/site/documentation/en-US/Red_Hat_Enterprise_Linux/6/html/Installation_Guide/s1-
redhat-config-kickstart-savefile.html 

 


